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SECURAFY
AI Services — n8n Workflow Specifications

Complete technical specifications for all 34 AI automation workflows across 6 verticals. Each spec includes trigger configuration, node-by-node breakdown, AI prompt templates, environment variables, integration notes, and deployment guidance.
WORKFLOW INDEX

	Code
	Workflow Name
	Vertical
	Time Saved
	Build

	LAW-01
	New Client Intake Assistant
	Law Firms
	6–10 hrs/week
	2–3 days

	LAW-02
	Deadline & Court Date Reminder System
	Law Firms
	4–6 hrs/week
	2–3 days

	LAW-03
	Document Summary & Review Prep
	Law Firms
	5–8 hrs/week
	3–4 days

	LAW-04
	Invoice & AR Follow-Up Bot
	Law Firms
	3–5 hrs/week
	1–2 days

	LAW-05
	Client Matter Status Update
	Law Firms
	4–7 hrs/week
	2–3 days

	LAW-06
	New Staff Onboarding Journey
	Law Firms
	4–6 hrs/new hire
	4–5 days

	CPA-01
	Client Document Request & Chase System
	CPA & Accounting
	8–12 hrs/week
	3–4 days

	CPA-02
	New Client Onboarding Workflow
	CPA & Accounting
	4–6 hrs/new client
	2–3 days

	CPA-03
	Tax Deadline Reminder System
	CPA & Accounting
	5–8 hrs/week
	2–3 days

	CPA-04
	Invoice & AR Follow-Up Bot
	CPA & Accounting
	3–5 hrs/week
	1–2 days

	CPA-05
	Client Inquiry Triage & Routing
	CPA & Accounting
	6–9 hrs/week
	3–4 days

	CPA-06
	Bookkeeping Anomaly & Variance Alert
	CPA & Accounting
	4–7 hrs/week per client block
	4–5 days

	CLUB-01
	Member Inquiry & Communication Assistant
	Country & Private Clubs
	5–8 hrs/week
	2–3 days

	CLUB-02
	Event & Tournament Coordination System
	Country & Private Clubs
	8–12 hrs/event
	3–4 days

	CLUB-03
	New Member Onboarding Journey
	Country & Private Clubs
	4–6 hrs/new member
	4–5 days

	CLUB-04
	Dining & Facility Reservation Follow-Up
	Country & Private Clubs
	3–5 hrs/week
	2–3 days

	CLUB-05
	Member Dues & Billing Communication
	Country & Private Clubs
	3–4 hrs/week
	2 days

	CLUB-06
	Review & Reputation Management
	Country & Private Clubs
	2–4 hrs/week
	2–3 days

	MFG-01
	Purchase Order Follow-Up & Supplier Chase
	Manufacturers
	6–10 hrs/week
	2–3 days

	MFG-02
	Customer Order Status Communication
	Manufacturers
	5–8 hrs/week
	3–4 days

	MFG-03
	Quality Non-Conformance (NCR) Intake & Routing
	Manufacturers
	4–7 hrs/week
	3–4 days

	MFG-04
	New Vendor / Supplier Onboarding Assistant
	Manufacturers
	4–6 hrs/new vendor
	2–3 days

	MFG-05
	Shift Handover & Production Digest
	Manufacturers
	5–8 hrs/week
	4–5 days

	MFG-06
	Compliance Document Expiry Alert System
	Manufacturers
	3–5 hrs/week
	2–3 days

	FO-01
	Universal Inbox Triage & Routing
	Front Office — Universal
	6–10 hrs/week
	3–4 days

	FO-02
	Lead Capture & First-Response (< 2 Minutes)
	Front Office — Universal
	5–8 hrs/week
	2–3 days

	FO-03
	Meeting Preparation Assistant
	Front Office — Universal
	4–6 hrs/week
	3–4 days

	FO-04
	Quote & Proposal Follow-Up Sequence
	Front Office — Universal
	4–6 hrs/week
	2–3 days

	FO-05
	Employee Onboarding Journey (30 Days)
	Front Office — Universal
	5–8 hrs/new hire
	4–5 days

	FO-06
	Internal AI Knowledge Base Assistant
	Front Office — Universal
	6–10 hrs/week across team
	5–7 days

	FO-07
	Weekly Business Performance Digest
	Front Office — Universal
	3–5 hrs/week
	3–4 days

	UNI-01
	Google Review & Reputation Responder
	Universal — All Industries
	2–4 hrs/week
	2–3 days

	UNI-02
	Social Media Content Pipeline
	Universal — All Industries
	5–8 hrs/week
	3–4 days

	UNI-03
	AI Sales Proposal Generator
	Universal — All Industries
	3–5 hrs/proposal
	2–3 days




ENVIRONMENT SETUP — ALL WORKFLOWS

All workflows require the following base environment variables configured in n8n Settings → Environment Variables:
	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=sk-ant-...               # Anthropic Claude API key
BUSINESS_NAME=Your Business Name           # Used in email signatures
BUSINESS_EMAIL=you@yourbusiness.com        # From address for emails
REPLY_TO_EMAIL=you@yourbusiness.com        # Reply-to for client emails
SLACK_ROUTING_CHANNEL=#general-routing     # Default Slack routing channel
N8N_WEBHOOK_BASE_URL=https://n8n.yourdomain.com  # Your n8n instance URL



Workflow-specific variables are listed in each spec below. All variables beginning with $env. are configured as n8n environment variables — never hardcoded in workflow nodes.


LAW FIRMS

LAW-01
New Client Intake Assistant

When a new potential client contacts the firm via website form or email, this workflow instantly classifies the inquiry, drafts a personalised acknowledgement, creates a CRM contact, and notifies the intake coordinator — all within 60 seconds.
	Trigger
	Webhook — web form submission or email parse

	Hours saved
	6–10 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$400–$600/mo

	Connections
	Webhook → Extract → AI → Parse → [Email + CRM + Slack] (parallel)



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	New Lead Webhook
	n8n-nodes-base.webhook
	Receives incoming lead from web form, email parser, or intake app

	2
	Extract Lead Data
	n8n-nodes-base.set
	Maps form fields: name, email, phone, message, source

	3
	AI: Classify & Draft Response
	n8n-nodes-base.httpRequest (Anthropic)
	Classifies matter type, assesses urgency, drafts acknowledgement email

	4
	Parse AI Response
	n8n-nodes-base.set
	Extracts JSON fields from AI response for downstream nodes

	5
	Send Acknowledgement
	n8n-nodes-base.gmail
	Sends personalised acknowledgement email to the prospect

	6
	Create CRM Contact
	n8n-nodes-base.hubspot
	Creates contact record in CRM with matter type and urgency tags

	7
	Notify Intake Coordinator
	n8n-nodes-base.slack
	Sends Slack alert with matter type, urgency, and AI summary



AI SYSTEM PROMPT
	You are an intake assistant for a law firm. Analyze the client inquiry and: 1) Classify matter type, 2) Assess urgency, 3) Check for conflict keywords, 4) Draft a warm 2-3 paragraph acknowledgement. Respond in JSON: {matterType, urgency, conflictFlags, subject, emailBody, internalNote}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
REPLY_TO_EMAIL=<your value here>
INTAKE_OWNER_ID=<your value here>
SLACK_INTAKE_CHANNEL=<your value here>
CLIO_BASE_URL=<your value here>



INTEGRATION NOTES
Runs in under 60 seconds from form submission to email delivered. No human touch required.

LAW-02
Deadline & Court Date Reminder System

Checks Clio for all matters with deadlines within 14, 7, or 2 days. For each, drafts a personalised reminder to the client and an alert to the attorney. Escalates if no acknowledgement is received.
	Trigger
	Schedule — daily 7am

	Hours saved
	4–6 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$350–$500/mo

	Connections
	Schedule → Fetch → Filter → AI → [Email Client + Slack Attorney] (parallel)



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Daily 7am Schedule
	n8n-nodes-base.scheduleTrigger
	Fires every morning at 7am Monday–Friday

	2
	Fetch Upcoming Deadlines
	n8n-nodes-base.httpRequest
	Pulls all open matters with deadlines from Clio API

	3
	Filter 14/7/2 Day Windows
	n8n-nodes-base.set
	Calculates days until deadline, filters to action windows

	4
	AI: Draft Reminder
	n8n-nodes-base.httpRequest (Anthropic)
	Drafts attorney internal note and client reminder email

	5
	Email Client Reminder
	n8n-nodes-base.gmail
	Sends personalised reminder to client with deadline details

	6
	Alert Attorney via Slack
	n8n-nodes-base.slack
	Posts deadline alert to attorneys channel



AI SYSTEM PROMPT
	You are a legal assistant. Draft professional deadline reminder communications for attorney (concise internal note with action items) and client (warm but clear reminder). Respond in JSON: {attorneySubject, attorneyBody, clientSubject, clientBody}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
CLIO_BASE_URL=<your value here>
CLIO_API_TOKEN=<your value here>
SLACK_ATTORNEYS_CHANNEL=<your value here>
REPLY_TO_EMAIL=<your value here>



INTEGRATION NOTES
Processes all matters in a single daily run. Attorneys only notified for imminent deadlines, not every reminder.

LAW-03
Document Summary & Review Prep

When any new document is uploaded to a matter in Clio or SharePoint, the workflow fetches the text, sends it to AI for analysis, and delivers a structured brief to the responsible attorney before they open the document.
	Trigger
	Webhook — document uploaded to matter folder

	Hours saved
	5–8 hrs/week

	Build time
	3–4 days

	Monthly retainer
	$500–$800/mo

	Connections
	Webhook → Fetch Doc → AI → Format → Email Attorney



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Document Upload Webhook
	n8n-nodes-base.webhook
	Triggered by Clio document upload event or SharePoint file watcher

	2
	Fetch Document Text
	n8n-nodes-base.httpRequest
	Downloads and extracts text from the uploaded document

	3
	AI: Analyse Document
	n8n-nodes-base.httpRequest (Anthropic)
	Extracts parties, dates, obligations, flags unusual clauses

	4
	Format Attorney Brief
	n8n-nodes-base.set
	Assembles the structured brief from AI JSON output

	5
	Email Brief to Attorney
	n8n-nodes-base.gmail
	Delivers the brief with the document summary before review



AI SYSTEM PROMPT
	You are a legal document analyst. Extract: 1) Document type and parties, 2) Key dates, 3) Obligations per party, 4) Payment terms, 5) Unusual/non-standard clauses, 6) 3-sentence summary. Respond in JSON: {docType, parties, keyDates, obligations, paymentTerms, unusualClauses, summary, reviewPriority}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
CLIO_BASE_URL=<your value here>
CLIO_API_TOKEN=<your value here>
REPLY_TO_EMAIL=<your value here>



INTEGRATION NOTES
Works with Clio, NetDocuments, SharePoint. Requires document URL to be passed in webhook payload. Supports PDF and DOCX via extraction service.

LAW-04
Invoice & AR Follow-Up Bot

Checks Clio Payments for invoices unpaid at exactly 14, 30, and 45 days. Drafts staged, professionally toned follow-up emails referencing the specific matter. Escalates to the billing partner at 45 days.
	Trigger
	Schedule — daily 8am Monday–Friday

	Hours saved
	3–5 hrs/week

	Build time
	1–2 days

	Monthly retainer
	$300–$450/mo

	Connections
	Schedule → Fetch → Calculate → AI → Email + (if 45d) Slack Escalation



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Daily AR Check
	n8n-nodes-base.scheduleTrigger
	Fires every weekday morning at 8am

	2
	Fetch Overdue Bills
	n8n-nodes-base.httpRequest
	Queries Clio API for outstanding bills by status

	3
	Calculate Days Overdue
	n8n-nodes-base.set
	Filters to exactly 14, 30, 45 day buckets

	4
	AI: Draft Follow-Up
	n8n-nodes-base.httpRequest (Anthropic)
	Drafts tone-appropriate follow-up email for each bucket

	5
	Send Follow-Up Email
	n8n-nodes-base.gmail
	Sends the staged follow-up to the client

	6
	Escalate to Partner (45d)
	n8n-nodes-base.slack
	Alerts billing partner in Slack for 45-day overdue invoices



AI SYSTEM PROMPT
	You are a billing coordinator for a law firm. Draft professional overdue invoice reminder. Tone escalates by days: 14d = gentle, 30d = firm, 45d = urgent with consequences. Always reference specific matter. Respond in JSON: {subject, body, escalateToPartner}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
CLIO_BASE_URL=<your value here>
CLIO_API_TOKEN=<your value here>
SLACK_BILLING_CHANNEL=<your value here>
REPLY_TO_EMAIL=<your value here>



INTEGRATION NOTES
Sends exactly ONE email per invoice per trigger window. Deduplication handled by day-exact filtering. Partner escalation is Slack-only — no auto-email.

LAW-05
Client Matter Status Update

Weekly workflow that fetches all active matters updated in the past 7 days from Clio. For each, the AI drafts a plain-English status update email to the client summarising recent activity and next steps.
	Trigger
	Schedule — every Monday 9am

	Hours saved
	4–7 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$400–$600/mo

	Connections
	Schedule → Fetch Matters → (loop each matter) AI Draft → Email Client



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Monday 9am Schedule
	n8n-nodes-base.scheduleTrigger
	Fires every Monday morning at 9am

	2
	Fetch Active Matters
	n8n-nodes-base.httpRequest
	Gets all open matters with activity in past 7 days from Clio

	3
	AI: Draft Status Update
	n8n-nodes-base.httpRequest (Anthropic)
	Writes plain-English client update from matter activity data

	4
	Email Status Update
	n8n-nodes-base.gmail
	Sends personalised status email to each client



AI SYSTEM PROMPT
	You are a client relations coordinator for a law firm. Write a warm, professional weekly update email. Summarise this week's activity in plain English (no jargon), explain next steps, and reassure the client. 3-4 short paragraphs. Respond in JSON: {subject, body}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
CLIO_BASE_URL=<your value here>
CLIO_API_TOKEN=<your value here>
REPLY_TO_EMAIL=<your value here>



INTEGRATION NOTES
Only sends updates for matters with actual activity this week. No activity = no email sent. Requires Clio activity entries to be populated by attorneys.

LAW-06
New Staff Onboarding Journey

A 30-day automated onboarding sequence triggered when a new hire is added to the HR system. Sends Day 1 welcome, Day 3 systems setup, Day 7 policy overview, Day 14 check-in, and Day 30 review prompt. Also assigns tasks to manager and IT.
	Trigger
	Webhook — new employee added to HR system

	Hours saved
	4–6 hrs/new hire

	Build time
	4–5 days

	Monthly retainer
	$400–$600/mo

	Connections
	Webhook → Extract → Day 1 Email → Wait(3d) → Day 3 Email → Wait(7d) → Day 7... (sequential chain)



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	New Employee Webhook
	n8n-nodes-base.webhook
	Triggered by HR system on new employee record creation

	2
	Extract Employee Data
	n8n-nodes-base.set
	Maps name, email, role, manager, start date

	3
	Day 1: Welcome Email
	n8n-nodes-base.gmail
	Sends personalised first-day welcome with orientation overview

	4
	Wait 3 Days
	n8n-nodes-base.wait
	Pauses workflow for 3 days before next communication

	5
	Day 3: Systems Email
	n8n-nodes-base.gmail
	Sends IT setup checklist and systems access guide

	6
	Continue Journey...
	n8n-nodes-base.wait
	Additional wait nodes for Day 7, 14, and 30 touchpoints



AI SYSTEM PROMPT
	Not applicable — this workflow uses pre-written email templates with dynamic personalisation rather than live AI generation for each email.



	REQUIRED ENVIRONMENT VARIABLES
REPLY_TO_EMAIL=<your value here>
IT_EMAIL=<your value here>
SLACK_IT_CHANNEL=<your value here>
HR_SYSTEM_WEBHOOK_SECRET=<your value here>



INTEGRATION NOTES
Uses n8n's Wait node for the time delays. For longer waits (14d, 30d), consider using a separate re-trigger mechanism or n8n's execution scheduling to avoid long-running executions.


CPA & ACCOUNTING

CPA-01
Client Document Request & Chase System

The moment a new engagement is created, this workflow generates a personalised, itemised document request and sends it to the client. Automated reminders fire at 14, 7, and 3 days before the deadline. Alerts the accountant if critical items remain missing at 3 days.
	Trigger
	Webhook — new engagement opened in practice management

	Hours saved
	8–12 hrs/week

	Build time
	3–4 days

	Monthly retainer
	$450–$700/mo

	Connections
	Webhook → Build Checklist → AI → Email → Wait(7d) → Chase → Wait(7d) → Final Chase



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	New Engagement Webhook
	n8n-nodes-base.webhook
	Triggered when engagement is opened in practice management system

	2
	Build Document Checklist
	n8n-nodes-base.set
	Extracts client info, engagement type, due date, portal URL

	3
	AI: Generate Document Request
	n8n-nodes-base.httpRequest (Anthropic)
	Generates personalised, plain-English document checklist by engagement type

	4
	Send Request to Client
	n8n-nodes-base.gmail
	Sends formatted document request email with upload portal link

	5
	Wait 7 Days
	n8n-nodes-base.wait
	Pauses to allow initial document upload period

	6
	7-Day Chase Reminder
	n8n-nodes-base.gmail
	Sends follow-up reminder if submission still incomplete



AI SYSTEM PROMPT
	You are a client services coordinator at a CPA firm. Based on engagement type, create a friendly itemised document list in plain English explaining why each item is needed. Respond in JSON: {subject, introText, documentList, closingText}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
CLIENT_PORTAL_URL=<your value here>
REPLY_TO_EMAIL=<your value here>
FIRM_NAME=<your value here>
SLACK_ACCOUNTANTS_CHANNEL=<your value here>



INTEGRATION NOTES
The engagement type field drives the AI's document list. Map your practice management engagement types to clear labels (Individual Tax Return, Business Tax Return, Bookkeeping, Audit, etc.).

CPA-02
New Client Onboarding Workflow

When a new engagement letter is signed (via DocuSign, PandaDoc, or manual webhook), this workflow generates a personalised welcome package, sends it within 2 hours, issues a portal invite, and notifies the engagement team in Slack with their action checklist.
	Trigger
	Webhook — engagement letter signed

	Hours saved
	4–6 hrs/new client

	Build time
	2–3 days

	Monthly retainer
	$350–$550/mo

	Connections
	Webhook → AI → [Email Client + Slack Team] (parallel)



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Engagement Signed Webhook
	n8n-nodes-base.webhook
	Triggered by e-signature platform on completed signing

	2
	AI: Generate Welcome Package
	n8n-nodes-base.httpRequest (Anthropic)
	Creates personalised welcome email and engagement summary

	3
	Send Welcome Email
	n8n-nodes-base.gmail
	Delivers welcome package to new client within 2 hours

	4
	Notify Accountant Team
	n8n-nodes-base.slack
	Alerts team in Slack with new client details and action items



AI SYSTEM PROMPT
	You are a client onboarding coordinator at a CPA firm. Create a warm, professional welcome package including: 1) Personalised welcome email, 2) Plain-English engagement summary, 3) Next steps with specific dates. Respond in JSON: {welcomeSubject, welcomeBody, nextSteps}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
REPLY_TO_EMAIL=<your value here>
FIRM_NAME=<your value here>
SLACK_ACCOUNTANTS_CHANNEL=<your value here>
CLIENT_PORTAL_URL=<your value here>



INTEGRATION NOTES
Connect to DocuSign, PandaDoc, or HelloSign via their webhook on document completion. The engagement type, accountant name, and client details must be passed in the webhook payload.

CPA-03
Tax Deadline Reminder System

Daily workflow that checks all clients' upcoming filing deadlines. Sends personalised reminders at 30, 14, 7, and 2 days before the deadline. Notifies the client when their return is ready for review and sends a confirmation when filed.
	Trigger
	Schedule — daily 7:30am Monday–Friday

	Hours saved
	5–8 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$400–$600/mo

	Connections
	Schedule → Fetch Deadlines → (loop per client) AI Draft → Email Client



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Daily 7:30am Schedule
	n8n-nodes-base.scheduleTrigger
	Fires every weekday morning to check deadlines

	2
	Fetch Client Deadlines
	n8n-nodes-base.httpRequest
	Queries practice management API for deadlines in the next 30 days

	3
	AI: Draft Deadline Reminder
	n8n-nodes-base.httpRequest (Anthropic)
	Writes tone-appropriate reminder based on days until deadline

	4
	Send Reminder Email
	n8n-nodes-base.gmail
	Delivers personalised deadline reminder to each client



AI SYSTEM PROMPT
	You are a tax coordinator. Draft a clear, friendly deadline reminder. Tone by urgency: 30d = gentle heads-up, 14d = reminder, 7d = action required, 2d = urgent. Respond in JSON: {subject, body}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
PRACTICE_MGMT_URL=<your value here>
PRACTICE_MGMT_TOKEN=<your value here>
REPLY_TO_EMAIL=<your value here>
FIRM_NAME=<your value here>



INTEGRATION NOTES
Integrates with Canopy, TaxDome, Karbon, or custom practice management via REST API. The deadline types (1040, 1120S, 990, etc.) should be passed from the practice management system.

CPA-04
Invoice & AR Follow-Up Bot

Pulls overdue invoices from QuickBooks or Xero. AI drafts professional, engagement-specific follow-ups at 14, 30, and 45 days. Notifies the partner at 45 days for personal outreach.
	Trigger
	Schedule — daily 8am Monday–Friday

	Hours saved
	3–5 hrs/week

	Build time
	1–2 days

	Monthly retainer
	$300–$450/mo

	Connections
	Schedule → Fetch → Bucket Filter → AI → Email + (45d) Slack Partner Alert



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Daily AR Schedule
	n8n-nodes-base.scheduleTrigger
	Fires every weekday at 8am

	2
	Fetch Overdue Invoices
	n8n-nodes-base.httpRequest
	Queries QuickBooks/Xero API for unpaid invoices past due date

	3
	Calculate Overdue Buckets
	n8n-nodes-base.set
	Groups invoices into 14/30/45 day buckets

	4
	AI: Draft Follow-Up
	n8n-nodes-base.httpRequest (Anthropic)
	Writes tone-escalating follow-up referencing specific engagement

	5
	Send AR Email
	n8n-nodes-base.gmail
	Sends staged follow-up to client

	6
	Partner Alert (45d)
	n8n-nodes-base.slack
	Notifies partner in Slack for 45-day overdue invoices



AI SYSTEM PROMPT
	You are a billing coordinator at a CPA firm. Draft professional AR follow-up. Tone: 14d = polite reminder, 30d = firm request, 45d = formal notice. Reference specific invoice and engagement. Respond in JSON: {subject, body}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
QB_BASE_URL=<your value here>
QB_REALM_ID=<your value here>
QB_ACCESS_TOKEN=<your value here>
SLACK_BILLING_CHANNEL=<your value here>
REPLY_TO_EMAIL=<your value here>



INTEGRATION NOTES
Use QuickBooks Online API v3 or Xero API. QuickBooks requires OAuth2 token refresh — use n8n's built-in QuickBooks credential management for automatic refresh.

CPA-05
Client Inquiry Triage & Routing

Monitors the firm's shared inbox continuously. AI classifies each email by category and determines whether it can be answered automatically. Simple queries (status checks, portal access, business hours) get auto-responses. Complex queries are routed to the correct accountant with a summary note.
	Trigger
	Gmail trigger — new unread email in shared inbox

	Hours saved
	6–9 hrs/week

	Build time
	3–4 days

	Monthly retainer
	$450–$700/mo

	Connections
	Gmail Trigger → AI → Parse → IF(canAutoRespond) → Auto-Reply | Slack Route



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Gmail Inbox Monitor
	n8n-nodes-base.gmailTrigger
	Polls shared inbox every minute for new unread emails

	2
	AI: Classify & Triage
	n8n-nodes-base.httpRequest (Anthropic)
	Classifies email type, determines routing and auto-response eligibility

	3
	Parse Triage Decision
	n8n-nodes-base.set
	Extracts routing decision from AI JSON response

	4
	Auto-Respond (Simple)
	n8n-nodes-base.gmail
	Sends automated response for routine queries

	5
	Route to Accountant
	n8n-nodes-base.slack
	Posts routing summary to accountants channel for complex queries



AI SYSTEM PROMPT
	You are an email triage specialist for a CPA firm. Classify email: TAX_QUERY, DOCUMENT_REQUEST, STATUS_CHECK, BILLING, APPOINTMENT, URGENT, GENERAL. Determine if auto-response is appropriate. Respond in JSON: {category, priority, assignTo, canAutoRespond, responseSubject, responseBody, internalNote}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
SLACK_ACCOUNTANTS_CHANNEL=<your value here>
FIRM_NAME=<your value here>
FIRM_EMAIL=<your value here>



INTEGRATION NOTES
Requires the IF node to branch based on canAutoRespond boolean. Only categories STATUS_CHECK and GENERAL should auto-respond. All financial and tax queries should always route to a human.

CPA-06
Bookkeeping Anomaly & Variance Alert

Weekly workflow that pulls the past 7 days of transaction data for each bookkeeping client from QuickBooks or Xero. AI reviews for unusual amounts, missing categorisation, duplicate entries, and category mismatches. Delivers a prioritised exception report to the accountant.
	Trigger
	Schedule — every Friday at 4pm

	Hours saved
	4–7 hrs/week per client block

	Build time
	4–5 days

	Monthly retainer
	$500–$800/mo

	Connections
	Schedule → Fetch Data → (per client) AI Review → Email Accountant



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Weekly Friday Schedule
	n8n-nodes-base.scheduleTrigger
	Fires every Friday at 4pm for end-of-week review

	2
	Fetch Transaction Data
	n8n-nodes-base.httpRequest
	Pulls last 7 days of transactions from QuickBooks/Xero per client

	3
	AI: Identify Anomalies
	n8n-nodes-base.httpRequest (Anthropic)
	Reviews transactions for anomalies, duplicates, and missing categories

	4
	Email Exception Report
	n8n-nodes-base.gmail
	Delivers prioritised exception report to responsible accountant



AI SYSTEM PROMPT
	You are a bookkeeping review specialist. Analyse transactions for: unusual amounts, missing categories, duplicates, round-number estimates, unusual vendors, category mismatches. Provide prioritised exception report. Respond in JSON: {anomalyCount, criticalItems, warningItems, infoItems, summary, recommendedActions}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
QB_BASE_URL=<your value here>
QB_REALM_ID=<your value here>
QB_ACCESS_TOKEN=<your value here>
ACCOUNTANT_EMAIL_MAP=<your value here>



INTEGRATION NOTES
For firms with many bookkeeping clients, use n8n's Split In Batches node to process clients in groups of 5-10 to stay within API rate limits. Each client needs their own QB realm ID configured.


COUNTRY & PRIVATE CLUBS

CLUB-01
Member Inquiry & Communication Assistant

Every member inquiry — regardless of how it arrives — is acknowledged within minutes. AI classifies the inquiry, drafts a warm response in the club's voice, routes to the correct department, and logs the interaction in the club management system.
	Trigger
	Webhook — email, web form, or voicemail transcript

	Hours saved
	5–8 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$400–$650/mo

	Connections
	Webhook → AI → [Email Member + Slack Route + Log CMS] (parallel)



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Member Inquiry Webhook
	n8n-nodes-base.webhook
	Receives inquiries from email, web form, or voicemail-to-text service

	2
	AI: Classify & Draft Response
	n8n-nodes-base.httpRequest (Anthropic)
	Classifies inquiry type, drafts warm acknowledgement, determines routing

	3
	Send Acknowledgement
	n8n-nodes-base.gmail
	Sends personalised acknowledgement to member email

	4
	Route to Department
	n8n-nodes-base.slack
	Posts to correct department Slack channel with inquiry summary

	5
	Log in Club System
	n8n-nodes-base.httpRequest
	Creates inquiry record in club management system (Jonas, Clubessential, etc.)



AI SYSTEM PROMPT
	You are a member services coordinator at a prestigious private club. Classify this inquiry and draft a warm, personalised acknowledgement. Categories: DINING, GOLF, EVENT, MEMBERSHIP, FACILITY, BILLING, COMPLAINT, GENERAL. Respond in JSON: {category, priority, routeTo, subject, acknowledgeBody, internalNote}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
SLACK_DINING_CHANNEL=<your value here>
SLACK_GOLF_CHANNEL=<your value here>
SLACK_EVENTS_CHANNEL=<your value here>
SLACK_MEMBERSHIP_CHANNEL=<your value here>
CLUB_MGMT_URL=<your value here>
REPLY_TO_EMAIL=<your value here>



INTEGRATION NOTES
Use a dynamic Slack channel selection based on the routeTo field. Map department names to Slack channel IDs in an environment variable lookup table.

CLUB-02
Event & Tournament Coordination System

When the events team creates a new event, this workflow generates the complete communication package: invitation, 14-day reminder, 7-day reminder, 2-day reminder, and post-event thank-you. All sent automatically with no manual work beyond the initial event creation.
	Trigger
	Webhook — new event created in club management system

	Hours saved
	8–12 hrs/event

	Build time
	3–4 days

	Monthly retainer
	$500–$750/mo

	Connections
	Webhook → AI → Fetch Members → (loop) Email + Slack Confirmation



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	New Event Webhook
	n8n-nodes-base.webhook
	Triggered when event is created in club management system

	2
	AI: Generate Full Comms Package
	n8n-nodes-base.httpRequest (Anthropic)
	Creates all event communications in one AI call for consistency

	3
	Fetch Invited Members
	n8n-nodes-base.httpRequest
	Gets member list based on event segment (all, golf, dining, etc.)

	4
	Send Invitations
	n8n-nodes-base.gmail
	Sends personalised invitations with RSVP links to all invited members

	5
	Notify Events Team
	n8n-nodes-base.slack
	Confirms invitations sent with count and reminder schedule



AI SYSTEM PROMPT
	You are an events coordinator at a prestigious private club. Create a complete event communication package: invitation, 7-day reminder, 2-day reminder, post-event thank-you. The club's tone is warm, exclusive, and inviting. Respond in JSON: {invitationSubject, invitationBody, reminder7Subject, reminder7Body, reminder2Subject, reminder2Body, thankYouSubject, thankYouBody}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
CLUB_MGMT_URL=<your value here>
CLUB_MGMT_TOKEN=<your value here>
RSVP_BASE_URL=<your value here>
SLACK_EVENTS_CHANNEL=<your value here>
REPLY_TO_EMAIL=<your value here>



INTEGRATION NOTES
Use n8n's Schedule node or Wait node to trigger the reminder sequences after specified intervals. For large member lists, use Gmail's batch send or an email service (SendGrid, Mailchimp) to avoid per-minute send limits.

CLUB-03
New Member Onboarding Journey

When a new member is approved, the AI generates a personalised 30-day welcome sequence tailored to their stated interests. Day 1 welcome, Day 7 facilities guide, Day 14 events introduction, Day 30 first-month check-in. Notifies membership director for a personal welcome call.
	Trigger
	Webhook — new member approved in club management system

	Hours saved
	4–6 hrs/new member

	Build time
	4–5 days

	Monthly retainer
	$500–$800/mo

	Connections
	Webhook → AI → [Day 1 Email + Slack Alert] → Wait(7d) → Day 7 Email → Wait(7d) → Day 14 → Wait(16d) → Day 30



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	New Member Approved Webhook
	n8n-nodes-base.webhook
	Triggered when membership application is approved

	2
	AI: Generate Welcome Series
	n8n-nodes-base.httpRequest (Anthropic)
	Creates personalised 30-day welcome sequence based on member interests

	3
	Day 1: Welcome Email
	n8n-nodes-base.gmail
	Sends personalised first welcome email to new member

	4
	Alert Membership Director
	n8n-nodes-base.slack
	Notifies director to schedule personal welcome call within 5 days

	5
	Wait 7 Days
	n8n-nodes-base.wait
	Pauses for Day 7 facilities guide (continues the chain)



AI SYSTEM PROMPT
	You are a member relations coordinator at a prestigious private club. Create a warm, personalised 30-day welcome email series. Tailor to stated interests. Generate Day 1, 7, 14, and 30 emails. Tone is exclusive, warm, and attentive. Respond in JSON: {day1Subject, day1Body, day7Subject, day7Body, day14Subject, day14Body, day30Subject, day30Body}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
SLACK_MEMBERSHIP_CHANNEL=<your value here>
REPLY_TO_EMAIL=<your value here>
CLUB_MGMT_URL=<your value here>



INTEGRATION NOTES
AI generates all four emails in a single call at the start. Store the generated email content in workflow static data or a database to use in subsequent Wait nodes without another AI call.

CLUB-04
Dining & Facility Reservation Follow-Up

Every booking — dining, golf, tennis, spa — triggers a personalised communication sequence: instant confirmation, 24-hour reminder, and post-visit thank-you with a discreet feedback request.
	Trigger
	Webhook — new reservation made in club management system

	Hours saved
	3–5 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$350–$500/mo

	Connections
	Webhook → AI → Confirmation Email → Wait(dynamic) → Reminder → Wait(after) → Thank-You



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	New Reservation Webhook
	n8n-nodes-base.webhook
	Triggered by reservation system on any new booking

	2
	AI: Generate Comms Set
	n8n-nodes-base.httpRequest (Anthropic)
	Creates confirmation, 24-hr reminder, and post-visit thank-you in one call

	3
	Send Confirmation
	n8n-nodes-base.gmail
	Sends immediate personalised confirmation to member

	4
	Wait Until 24hrs Before
	n8n-nodes-base.wait
	Calculates and waits until 24 hours before the reservation

	5
	Send Reminder
	n8n-nodes-base.gmail
	Sends personalised day-before reminder

	6
	Wait Until Day After
	n8n-nodes-base.wait
	Waits until the day after the visit for follow-up

	7
	Send Thank-You
	n8n-nodes-base.gmail
	Sends personalised thank-you with feedback request



AI SYSTEM PROMPT
	You are a hospitality coordinator at a prestigious private club. Create personalised reservation communications: confirmation, 24-hour reminder, and post-visit thank you with discreet feedback request. Respond in JSON: {confirmSubject, confirmBody, reminderSubject, reminderBody, thankYouSubject, thankYouBody}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
REPLY_TO_EMAIL=<your value here>
FEEDBACK_FORM_URL=<your value here>



INTEGRATION NOTES
For the dynamic wait (24 hours before reservation), use n8n's Wait node with 'Specific Time' mode and calculate the target time as: reservationDateTime minus 24 hours. Pass the calculated ISO timestamp as the resume time.

CLUB-05
Member Dues & Billing Communication

Generates monthly dues statements and sends respectful, member-dignity-preserving billing reminders at 14 and 30 days overdue. The AI is instructed to maintain the club's high-standards tone throughout. Escalates to Membership Director at 30 days.
	Trigger
	Schedule — monthly on the 1st

	Hours saved
	3–4 hrs/week

	Build time
	2 days

	Monthly retainer
	$300–$450/mo

	Connections
	Schedule → Fetch Overdue → (per member) AI Draft → Email Member



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Monthly 1st Schedule
	n8n-nodes-base.scheduleTrigger
	Fires on the 1st of each month at 8am

	2
	Fetch Overdue Accounts
	n8n-nodes-base.httpRequest
	Gets all member accounts overdue by 14+ days from club billing system

	3
	AI: Draft Billing Comms
	n8n-nodes-base.httpRequest (Anthropic)
	Drafts discreet, dignity-preserving billing reminder scaled by days overdue

	4
	Send Billing Email
	n8n-nodes-base.gmail
	Delivers billing communication to member's email on file



AI SYSTEM PROMPT
	You are a membership coordinator at a prestigious private club. Draft a billing reminder that is discreet, respectful, and maintains member dignity. Never aggressive or threatening. 14d = gentle reminder, 30d = warm but clear. Respond in JSON: {subject, body, escalateToDirector}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
CLUB_MGMT_URL=<your value here>
CLUB_MGMT_TOKEN=<your value here>
SLACK_MEMBERSHIP_CHANNEL=<your value here>
REPLY_TO_EMAIL=<your value here>



INTEGRATION NOTES
Always use a conditional node after AI response to check escalateToDirector flag and trigger a Slack notification to the Membership Director for accounts over 30 days.

CLUB-06
Review & Reputation Management

Monitors Google Business Profile for new reviews. AI drafts sophisticated, personalised responses in the club's voice for GM approval. Compiles monthly sentiment reports. For negative reviews, flags for immediate member follow-up.
	Trigger
	Schedule — every 4 hours

	Hours saved
	2–4 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$350–$500/mo

	Connections
	Schedule → Fetch Reviews → (per new review) AI Draft → Slack GM Approval



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	4-Hour Review Check
	n8n-nodes-base.scheduleTrigger
	Checks for new Google reviews every 4 hours

	2
	Fetch Google Reviews
	n8n-nodes-base.httpRequest
	Calls Google Business Profile API for new reviews

	3
	AI: Draft Review Response
	n8n-nodes-base.httpRequest (Anthropic)
	Creates sophisticated, personalised response in club's voice

	4
	Queue for GM Approval
	n8n-nodes-base.slack
	Sends draft to GM's Slack with approval workflow (✅/✏️)



AI SYSTEM PROMPT
	You are representing a prestigious private club. Draft a sophisticated, warm, personalised response to this review. Acknowledge specific points. Be genuine, not formulaic. 2-3 sentences for positive, 3-4 for negative (with empathy and corrective action). Respond in JSON: {responseText, sentiment, followUpRequired, internalNote}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
GOOGLE_ACCOUNT_ID=<your value here>
GOOGLE_LOCATION_ID=<your value here>
GOOGLE_API_TOKEN=<your value here>
SLACK_GM_CHANNEL=<your value here>



INTEGRATION NOTES
Requires Google My Business API access (OAuth2). After GM approves in Slack (using Slack interactive buttons), a second workflow posts the approved response to Google via the API.


MANUFACTURERS

MFG-01
Purchase Order Follow-Up & Supplier Chase

Checks ERP for purchase orders that haven't been acknowledged by the supplier within 24 hours. AI drafts a professional, firm follow-up email referencing the specific PO and line items. Escalates to the purchasing manager in Slack at 48 hours.
	Trigger
	Schedule — every 4 hours Monday–Friday

	Hours saved
	6–10 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$400–$650/mo

	Connections
	Schedule → Fetch Unacked POs → (per PO) AI Draft → [Email Supplier + Slack Alert] (parallel)



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	4-Hour PO Check
	n8n-nodes-base.scheduleTrigger
	Checks for unacknowledged POs every 4 hours during business hours

	2
	Fetch Unacknowledged POs
	n8n-nodes-base.httpRequest
	Queries ERP for POs issued 24+ hours ago without supplier acknowledgement

	3
	AI: Draft Supplier Chase
	n8n-nodes-base.httpRequest (Anthropic)
	Drafts professional follow-up referencing PO, line items, and delivery date

	4
	Send Chase to Supplier
	n8n-nodes-base.gmail
	Sends chase email to supplier contact on file

	5
	Alert Purchasing Manager
	n8n-nodes-base.slack
	Notifies purchasing manager channel that chase was sent



AI SYSTEM PROMPT
	You are a purchasing coordinator. Draft a professional, firm but polite email chasing a supplier for PO acknowledgement. Reference specific PO number and line items. Request confirmation by EOD. Respond in JSON: {subject, body, escalateRequired}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
ERP_BASE_URL=<your value here>
ERP_API_TOKEN=<your value here>
SLACK_PURCHASING_CHANNEL=<your value here>
COMPANY_EMAIL=<your value here>



INTEGRATION NOTES
Works with any ERP that exposes a REST API (SAP, Epicor, Infor, SYSPRO, JobBoss). The PO acknowledgement status field name will vary by ERP — map to your system's field naming. Never write directly to production ERP tables.

MFG-02
Customer Order Status Communication

When any order status changes in the ERP (confirmed, in production, shipped, delayed), an AI-drafted customer update is sent automatically. For delays, the notification is proactive, apologetic, and includes a revised timeline.
	Trigger
	Webhook — ERP order status change event

	Hours saved
	5–8 hrs/week

	Build time
	3–4 days

	Monthly retainer
	$450–$700/mo

	Connections
	Webhook → AI → [Email Customer + Slack Log] (parallel)



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	ERP Order Status Webhook
	n8n-nodes-base.webhook
	Receives order status change events from ERP webhook/integration layer

	2
	AI: Draft Customer Update
	n8n-nodes-base.httpRequest (Anthropic)
	Creates status-appropriate customer notification, delay handling built in

	3
	Send Update to Customer
	n8n-nodes-base.gmail
	Sends personalised order status email to customer contact

	4
	Log in Customer Service Channel
	n8n-nodes-base.slack
	Posts update summary to customer service Slack channel



AI SYSTEM PROMPT
	You are a customer service coordinator at a manufacturer. Draft a clear, professional order status update. For delays: be proactive, apologetic, explain briefly, give revised timeline. For good news: be positive and informative. Respond in JSON: {subject, body, isDelay}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
SLACK_CUSTOMER_SERVICE_CHANNEL=<your value here>
COMPANY_EMAIL=<your value here>
COMPANY_NAME=<your value here>



INTEGRATION NOTES
Many ERPs support outbound webhooks on status changes — check your ERP's integration documentation. If your ERP does not support webhooks, use a polling approach: query the order status API every 30 minutes and compare against last known state stored in n8n's static data.

MFG-03
Quality Non-Conformance (NCR) Intake & Routing

When a quality non-conformance report is submitted (via web form, quality system, or email), AI classifies severity, identifies the correct quality engineer, sends acknowledgement to the reporter, and creates the NCR record in the quality system — all within 5 minutes.
	Trigger
	Webhook — NCR form submission

	Hours saved
	4–7 hrs/week

	Build time
	3–4 days

	Monthly retainer
	$450–$700/mo

	Connections
	Webhook → AI → [Acknowledge Reporter + Slack Route + Create NCR Record] (parallel)



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	NCR Submitted Webhook
	n8n-nodes-base.webhook
	Receives NCR submissions from quality forms or quality management system

	2
	AI: Classify NCR Severity
	n8n-nodes-base.httpRequest (Anthropic)
	Classifies severity, assigns engineer, drafts acknowledgement, suggests containment

	3
	Acknowledge Reporter
	n8n-nodes-base.gmail
	Sends NCR acknowledgement with reference number and SLA to reporter

	4
	Route to Quality Engineer
	n8n-nodes-base.slack
	Posts classified NCR to quality team channel with assignment and urgency

	5
	Create NCR in Quality System
	n8n-nodes-base.httpRequest
	Creates NCR record via API in your quality management system



AI SYSTEM PROMPT
	You are a quality management specialist. Analyse this NCR and: 1) Classify severity (CRITICAL/MAJOR/MINOR), 2) Identify process area, 3) Suggest engineer, 4) Draft reporter acknowledgement, 5) Suggest containment. Respond in JSON: {severity, processArea, assignTo, acknowledgementBody, containmentActions, slaHours}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
SLACK_QUALITY_CHANNEL=<your value here>
QUALITY_SYSTEM_URL=<your value here>
QUALITY_SYSTEM_TOKEN=<your value here>
COMPANY_EMAIL=<your value here>



INTEGRATION NOTES
The quality engineer assignment logic in the AI prompt can be enhanced by including a list of engineers and their specialisations in the system prompt. Update monthly as team changes.

MFG-04
New Vendor / Supplier Onboarding Assistant

The moment a new vendor is approved, this workflow sends a complete onboarding document request (W-9, insurance, quality certs, banking, code of conduct). Tracks what has been submitted. Sends reminders. Alerts procurement when complete.
	Trigger
	Webhook — new vendor approved in ERP/procurement system

	Hours saved
	4–6 hrs/new vendor

	Build time
	2–3 days

	Monthly retainer
	$350–$550/mo

	Connections
	Webhook → [Email Vendor + Slack Procurement] → Wait(5d) → Check Status → IF(incomplete) → Chase Email



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	New Vendor Approved Webhook
	n8n-nodes-base.webhook
	Triggered when vendor is approved in ERP or procurement system

	2
	Send Document Request
	n8n-nodes-base.gmail
	Sends complete onboarding document checklist with supplier portal link

	3
	Notify Procurement Team
	n8n-nodes-base.slack
	Alerts procurement channel that onboarding has started

	4
	Wait 5 Days
	n8n-nodes-base.wait
	Pauses for initial document submission window

	5
	Check Submission Status
	n8n-nodes-base.httpRequest
	Queries supplier portal API for submission completeness

	6
	Send Chase (If Incomplete)
	n8n-nodes-base.gmail
	Sends reminder email if not all documents received after 5 days



AI SYSTEM PROMPT
	Not applicable — this workflow uses structured email templates rather than AI generation. The document list is standardised across all vendors.



	REQUIRED ENVIRONMENT VARIABLES
SUPPLIER_PORTAL_URL=<your value here>
PROCUREMENT_EMAIL=<your value here>
SLACK_PROCUREMENT_CHANNEL=<your value here>
COMPANY_NAME=<your value here>
COMPANY_EMAIL=<your value here>



INTEGRATION NOTES
Build a simple supplier portal using n8n's built-in form feature or a Typeform/JotForm integration where vendors upload their documents. Store completion status in n8n's database or a simple spreadsheet.

MFG-05
Shift Handover & Production Digest

Fires 5 minutes before each shift ends. Pulls production metrics from the ERP. AI generates a structured shift handover report covering output vs target, downtime, quality issues, and open items for the incoming shift. Delivered by email to all supervisors.
	Trigger
	Schedule — 5:55am, 1:55pm, 9:55pm (5 min before shift end)

	Hours saved
	5–8 hrs/week

	Build time
	4–5 days

	Monthly retainer
	$500–$800/mo

	Connections
	Schedule → Fetch ERP Data → AI → Email All Supervisors



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Shift-End Schedule Triggers
	n8n-nodes-base.scheduleTrigger
	Three cron triggers at 5:55am, 1:55pm, and 9:55pm

	2
	Pull Shift Metrics from ERP
	n8n-nodes-base.httpRequest
	Fetches production data: output, downtime, NCRs, open work orders

	3
	AI: Generate Handover Report
	n8n-nodes-base.httpRequest (Anthropic)
	Creates scannable handover summary with output vs target and open items

	4
	Email Report to Supervisors
	n8n-nodes-base.gmail
	Delivers formatted handover report to all shift supervisors



AI SYSTEM PROMPT
	You are a production supervisor creating a shift handover report. Write a clear, structured summary readable in 2 minutes. Include: output vs target, equipment issues, quality NCRs, open items for next shift, safety incidents. Use bullet points. Be factual. Respond in JSON: {shiftSummary, openItems, safetyItems, handoverNotes, outputVsTarget}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
ERP_BASE_URL=<your value here>
ERP_API_TOKEN=<your value here>
SUPERVISOR_EMAIL_LIST=<your value here>
COMPANY_NAME=<your value here>



INTEGRATION NOTES
The ERP shift summary endpoint will vary by system. For ERPs without a native shift summary API, create a custom view or report in your ERP that n8n can query as a simple data export (CSV or JSON endpoint).

MFG-06
Compliance Document Expiry Alert System

Checks all supplier and internal compliance documents daily. Sends renewal requests at 90, 30, and 7 days before expiry. Escalates to the compliance manager when items aren't renewed. Prevents audit surprises completely.
	Trigger
	Schedule — daily 6am

	Hours saved
	3–5 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$350–$500/mo

	Connections
	Schedule → Fetch Expiring → (per document) AI Draft → Email Owner



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Daily 6am Compliance Check
	n8n-nodes-base.scheduleTrigger
	Fires every morning to check all compliance document expiry dates

	2
	Fetch Expiring Documents
	n8n-nodes-base.httpRequest
	Queries ERP/document management for items expiring within 90 days

	3
	AI: Draft Renewal Request
	n8n-nodes-base.httpRequest (Anthropic)
	Drafts appropriate renewal request email scaled by urgency level

	4
	Send Renewal Request
	n8n-nodes-base.gmail
	Delivers renewal request to document owner or supplier contact



AI SYSTEM PROMPT
	You are a compliance coordinator. Draft a professional renewal request for expiring compliance document. Explain what is expiring, when, and what is needed. Include consequences of lapse. Be clear but not alarmist. Respond in JSON: {subject, body, urgencyLevel}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
ERP_BASE_URL=<your value here>
ERP_API_TOKEN=<your value here>
COMPLIANCE_MANAGER_EMAIL=<your value here>
COMPANY_EMAIL=<your value here>



INTEGRATION NOTES
Maintain a compliance document register in your ERP or a spreadsheet. Each record needs: document type, owner email, expiry date, consequence of lapse. The workflow reads this register and drives all communications from it.


FRONT OFFICE — UNIVERSAL

FO-01
Universal Inbox Triage & Routing

The most universally valuable automation in the library. Monitors any shared inbox continuously. AI classifies every email by intent, assigns priority, routes to the right person, and automatically responds to routine queries. Works for any business in any industry.
	Trigger
	Gmail trigger — new unread email in shared inbox

	Hours saved
	6–10 hrs/week

	Build time
	3–4 days

	Monthly retainer
	$450–$700/mo

	Connections
	Gmail Trigger → AI → Format → IF(canAutoRespond) → Auto-Reply | Slack Route



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Gmail Shared Inbox Monitor
	n8n-nodes-base.gmailTrigger
	Polls shared inbox (info@, sales@, support@) every minute for new emails

	2
	AI: Triage & Route
	n8n-nodes-base.httpRequest (Anthropic)
	Classifies email, determines routing, drafts auto-response where appropriate

	3
	Format Routing Decision
	n8n-nodes-base.set
	Extracts routing fields and auto-respond boolean from AI JSON

	4
	Auto-Respond (Routine)
	n8n-nodes-base.gmail
	Sends automated response for standard/routine queries only

	5
	Route to Team Member
	n8n-nodes-base.slack
	Posts routing alert to team channel with summary and assignment



AI SYSTEM PROMPT
	You are an expert email triage specialist. Classify and route: LEAD_INQUIRY, SUPPORT, BILLING, APPOINTMENT, PARTNERSHIP, VENDOR, JOB_APP, SPAM, URGENT, GENERAL. For routine queries, draft complete response. Respond in JSON: {category, priority, routeTo, canAutoRespond, responseSubject, responseBody, internalNote, estimatedHandleTime}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
SLACK_ROUTING_CHANNEL=<your value here>
BUSINESS_NAME=<your value here>
BUSINESS_EMAIL=<your value here>



INTEGRATION NOTES
Only set canAutoRespond=true for truly routine queries where an incorrect AI response would not cause harm: business hours, address, basic FAQ. All lead inquiries, complaints, and billing questions should always route to a human.

FO-02
Lead Capture & First-Response (< 2 Minutes)

The most important speed automation in the library. Every lead — regardless of channel — gets a personalised acknowledgement within 2 minutes. AI scores the lead, personalises the response, creates the CRM record, and notifies the sales team simultaneously.
	Trigger
	Webhook — any lead source (web form, social, phone)

	Hours saved
	5–8 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$400–$600/mo

	Connections
	Webhook → AI → [Email Lead + Create CRM + Slack Alert] (parallel, all within 90 seconds)



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Lead Capture Webhook
	n8n-nodes-base.webhook
	Receives leads from all sources: web forms, Facebook leads, Google ads, etc.

	2
	AI: Score & Draft Response
	n8n-nodes-base.httpRequest (Anthropic)
	Scores lead 1-10, identifies likely need, drafts personalised first response

	3
	Send First Response (< 2min)
	n8n-nodes-base.gmail
	Sends personalised acknowledgement immediately after AI generates it

	4
	Create CRM Record
	n8n-nodes-base.hubspot
	Creates lead record with AI score and likely need tags

	5
	Notify Sales Team
	n8n-nodes-base.slack
	Posts lead summary to sales channel with score and recommended action



AI SYSTEM PROMPT
	You are a sales development specialist. Evaluate this lead: 1) Score fit 1-10, 2) Identify likely need/pain point, 3) Draft personalised first-response email that references their specific situation. The response should feel handwritten, not templated. Respond in JSON: {leadScore, fitRating, likelyNeed, responseSubject, responseBody, followUpNote, urgency}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
REPLY_TO_EMAIL=<your value here>
SLACK_SALES_CHANNEL=<your value here>
BUSINESS_NAME=<your value here>



INTEGRATION NOTES
Integrate with your web form provider (Gravity Forms, Typeform, WPForms) via webhook. For Facebook/Instagram lead ads, use Facebook Lead Ads trigger. For Google ads lead forms, use a Zapier-to-n8n bridge or Google Sheets intermediary.

FO-03
Meeting Preparation Assistant

Every evening, checks the calendar for meetings happening the next day. For each external meeting, AI pulls CRM history, recent email context, and open items to compile a concise meeting brief. Delivered to the meeting owner's inbox before they leave for the day.
	Trigger
	Schedule — daily 6pm Monday–Friday

	Hours saved
	4–6 hrs/week

	Build time
	3–4 days

	Monthly retainer
	$400–$650/mo

	Connections
	Schedule → Fetch Calendar → (per external meeting) AI Brief → Email Owner



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Daily 6pm Schedule
	n8n-nodes-base.scheduleTrigger
	Fires every weekday evening at 6pm to prep next day's meetings

	2
	Fetch Tomorrow's Meetings
	n8n-nodes-base.httpRequest
	Queries Google Calendar API for next day's external meetings

	3
	AI: Generate Meeting Brief
	n8n-nodes-base.httpRequest (Anthropic)
	Compiles background, last interaction, open items, and talking points

	4
	Deliver Brief by Email
	n8n-nodes-base.gmail
	Emails the meeting brief to the meeting owner



AI SYSTEM PROMPT
	You are an executive assistant. Create a concise, actionable pre-meeting brief: 1) Who you're meeting and their context, 2) Last interaction summary, 3) Open items/commitments, 4) Suggested talking points, 5) Background notes. Scannable in 3 minutes. Respond in JSON: {attendeeName, attendeeContext, lastInteraction, openItems, suggestedTalkingPoints, backgroundNotes}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
GOOGLE_CALENDAR_TOKEN=<your value here>
REPLY_TO_EMAIL=<your value here>
USER_EMAIL=<your value here>



INTEGRATION NOTES
Filter to external meetings only using the attendees field — skip meetings where all attendees share your company domain. Enrich context by adding a HubSpot or Salesforce lookup for each external attendee before the AI step.

FO-04
Quote & Proposal Follow-Up Sequence

Checks CRM for quotes and proposals sent more than 3 days ago with no response. AI drafts value-adding follow-ups (not just 'did you get my email?') at 3, 7, and 14 days. Each follow-up is different and adds something new. Sales manager notified at 14 days.
	Trigger
	Schedule — daily 9am Monday–Friday

	Hours saved
	4–6 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$350–$550/mo

	Connections
	Schedule → Fetch Stale Quotes → (per quote) AI → Email + (if 14d) Slack Escalation



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Daily 9am Quote Check
	n8n-nodes-base.scheduleTrigger
	Fires every weekday at 9am to check for stale open quotes

	2
	Fetch Open Quotes Without Response
	n8n-nodes-base.httpRequest
	Queries CRM for deals in quote_sent stage with no recent activity

	3
	AI: Draft Value-Add Follow-Up
	n8n-nodes-base.httpRequest (Anthropic)
	Drafts distinct, personalised follow-ups at each interval adding genuine value

	4
	Send Follow-Up Email
	n8n-nodes-base.gmail
	Sends the AI-drafted follow-up to the prospect

	5
	Escalate at 14 Days
	n8n-nodes-base.slack
	Notifies sales manager in Slack when quote reaches 14 days without response



AI SYSTEM PROMPT
	You are a sales professional following up on a proposal. Add genuine value — don't just ask if they received it. 3d = interest + offer to answer questions, 7d = relevant case study or benefit, 14d = gentle urgency + call offer. Personalise to their industry/situation. Respond in JSON: {subject, body, suggestCall}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
REPLY_TO_EMAIL=<your value here>
SLACK_SALES_CHANNEL=<your value here>
BUSINESS_NAME=<your value here>
CRM_BASE_URL=<your value here>



INTEGRATION NOTES
Tag sent follow-ups in CRM to prevent duplicate sends. Use a CRM custom property (e.g. last_ai_followup_date) updated after each send to prevent the same email being sent twice.

FO-05
Employee Onboarding Journey (30 Days)

Universal onboarding automation for any business. AI generates a personalised 30-day sequence tailored to the employee's role and department. Simultaneously creates manager and IT task checklists in Slack. Works for any HR system that supports webhooks.
	Trigger
	Webhook — new employee added to HR system

	Hours saved
	5–8 hrs/new hire

	Build time
	4–5 days

	Monthly retainer
	$500–$750/mo

	Connections
	Webhook → AI → [Day 1 Email + Manager Email + IT Slack] (parallel)



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	New Employee HR Webhook
	n8n-nodes-base.webhook
	Triggered by HR system on new employee record creation

	2
	AI: Generate 30-Day Plan
	n8n-nodes-base.httpRequest (Anthropic)
	Creates personalised email sequence + manager/IT task lists for this role

	3
	Day 1 Welcome Email
	n8n-nodes-base.gmail
	Sends personalised Day 1 welcome email to new hire

	4
	Manager Task Notification
	n8n-nodes-base.gmail
	Emails manager their onboarding checklist for this specific hire

	5
	IT Setup Notification
	n8n-nodes-base.slack
	Posts IT setup checklist to IT channel with employee details and start date



AI SYSTEM PROMPT
	You are an HR onboarding specialist. Create a personalised 30-day onboarding email series for this employee's role and department. Generate Day 1, 3, 7, 14, and 30 emails plus a manager task list and IT setup list. Respond in JSON: {day1Subject, day1Body, day3Subject, day3Body, day7Subject, day7Body, day14Subject, day14Body, day30Subject, day30Body, managerTaskList, itTaskList}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
REPLY_TO_EMAIL=<your value here>
SLACK_IT_CHANNEL=<your value here>
COMPANY_NAME=<your value here>



INTEGRATION NOTES
Store all AI-generated email content at workflow start in n8n's static data or a database record. Use this stored content for subsequent wait-and-send steps rather than calling AI again. This ensures consistency and reduces API costs.

FO-06
Internal AI Knowledge Base Assistant

An always-on internal assistant that employees can ask any question in Slack. The AI answers from the company's own policy documents, procedures, and FAQs stored in a knowledge base. Flags unanswered questions for KB improvement. Eliminates the HR interrupt cycle.
	Trigger
	Slack bot mention (@knowledgebase or @ask)

	Hours saved
	6–10 hrs/week across team

	Build time
	5–7 days

	Monthly retainer
	$600–$1,000/mo

	Connections
	Slack Trigger → KB Search → AI → Slack Reply (in thread)



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Slack Bot Mention Trigger
	n8n-nodes-base.slackTrigger
	Fires when any employee mentions the knowledge base bot in any channel

	2
	Fetch Relevant KB Documents
	n8n-nodes-base.httpRequest
	Semantic search of your knowledge base to retrieve relevant documents

	3
	AI: Answer from KB
	n8n-nodes-base.httpRequest (Anthropic)
	Answers from retrieved documents only. States clearly if answer not found.

	4
	Reply in Slack Thread
	n8n-nodes-base.slack
	Posts the AI answer directly in the thread where the question was asked



AI SYSTEM PROMPT
	You are an internal company assistant. Answer this employee question using ONLY the provided company documents. Be helpful and specific. If the answer is not in the documents, say clearly that you don't have that information and suggest who to ask. Never make up policy information. Respond in JSON: {answer, confidence, sourceDocuments, needsEscalation, escalateTo}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
KB_SEARCH_URL=<your value here>
KB_SEARCH_TOKEN=<your value here>
SLACK_BOT_TOKEN=<your value here>
ESCALATION_CHANNEL=<your value here>



INTEGRATION NOTES
Build your knowledge base by uploading policy documents to a vector database (Pinecone, Weaviate, or n8n's built-in vector storage). Populate with: employee handbook, HR policies, IT procedures, product/service FAQs, process guides. Update monthly.

FO-07
Weekly Business Performance Digest

The most loved automation by business owners. Every Monday morning before they check email, a clean, AI-written weekly business digest lands in their inbox. Revenue vs prior week, pipeline movement, AR summary, wins, concerns, and recommendations. No manual compilation required.
	Trigger
	Schedule — every Monday 7am

	Hours saved
	3–5 hrs/week

	Build time
	3–4 days

	Monthly retainer
	$400–$600/mo

	Connections
	Schedule → [Fetch Financials + Fetch CRM] (parallel) → AI Digest → Email Owner



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Monday 7am Schedule
	n8n-nodes-base.scheduleTrigger
	Fires every Monday morning at 7am

	2
	Fetch Financial Metrics
	n8n-nodes-base.httpRequest
	Pulls P&L summary from QuickBooks or Xero for the past week

	3
	Fetch CRM Pipeline
	n8n-nodes-base.httpRequest
	Gets deal movements, new leads, and closed deals from CRM

	4
	AI: Generate Weekly Digest
	n8n-nodes-base.httpRequest (Anthropic)
	Writes insightful business digest from combined data sources

	5
	Email Digest to Owner
	n8n-nodes-base.gmail
	Delivers the weekly digest to the owner/leadership team



AI SYSTEM PROMPT
	You are a business intelligence analyst. Create a concise, insightful weekly business digest for the owner. Include: revenue vs prior week, pipeline movements, cash/AR summary, wins, concerns, and 1-2 recommendations. Use numbers. Flag anything needing attention. One readable page max. Respond in JSON: {weekSummary, revenueHighlight, pipelineHighlight, arHighlight, wins, concerns, recommendations, weekRating}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
QB_BASE_URL=<your value here>
QB_REALM_ID=<your value here>
QB_ACCESS_TOKEN=<your value here>
CRM_BASE_URL=<your value here>
CRM_TOKEN=<your value here>
OWNER_EMAIL=<your value here>



INTEGRATION NOTES
Add more data sources over time: Google Analytics (traffic), project management (completed tasks), support system (ticket volume). Each additional source makes the digest more complete. The AI synthesises across all of them.


UNIVERSAL — ALL INDUSTRIES

UNI-01
Google Review & Reputation Responder

A must-have for any business with a Google Business Profile. Monitors for new reviews, drafts professional responses in the client's specific brand voice, and queues them for a quick approval before posting. Includes a monthly sentiment report.
	Trigger
	Schedule — every 2 hours

	Hours saved
	2–4 hrs/week

	Build time
	2–3 days

	Monthly retainer
	$300–$500/mo

	Connections
	Schedule → Fetch Reviews → (per new review) AI → Slack Approval Queue



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	2-Hour Review Check
	n8n-nodes-base.scheduleTrigger
	Checks for new Google reviews every 2 hours

	2
	Fetch New Reviews
	n8n-nodes-base.httpRequest
	Queries Google Business Profile API for reviews since last check

	3
	AI: Draft Response
	n8n-nodes-base.httpRequest (Anthropic)
	Creates genuine, personalised response in the client's brand voice

	4
	Queue for Approval
	n8n-nodes-base.slack
	Posts draft to management Slack with ✅/✏️ approval workflow



AI SYSTEM PROMPT
	You are managing online reputation for a business. Draft a professional, genuine response to this review. Positive reviews: thank specifically, reference something unique they mentioned. Negative: acknowledge experience, apologise sincerely, offer to make it right offline. Never defensive. Never offer discounts publicly. Under 150 words. Respond in JSON: {responseText, sentiment, starRating, requiresFollowUp, internalAction}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
GOOGLE_ACCOUNT_ID=<your value here>
GOOGLE_LOCATION_ID=<your value here>
GOOGLE_API_TOKEN=<your value here>
SLACK_MANAGEMENT_CHANNEL=<your value here>
BUSINESS_NAME=<your value here>



INTEGRATION NOTES
Implement a second workflow triggered by Slack interactive button approval to post the response to Google via the My Business API. n8n supports Slack interactive buttons via the Slack trigger node with payload type 'block_actions'.

UNI-02
Social Media Content Pipeline

Transforms a simple weekly content brief into a full week of social posts across LinkedIn, Facebook, and Instagram. AI creates platform-optimised versions of each message. Queues for approval in Slack before scheduling.
	Trigger
	Webhook — weekly content brief OR Monday schedule

	Hours saved
	5–8 hrs/week

	Build time
	3–4 days

	Monthly retainer
	$350–$600/mo

	Connections
	Webhook → AI → Format → Slack Approval Preview



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	Content Brief Webhook
	n8n-nodes-base.webhook
	Receives weekly brief with topic, key messages, and any promotions

	2
	AI: Generate Weekly Content
	n8n-nodes-base.httpRequest (Anthropic)
	Creates 9 posts (3 platforms × 3 days) from the single brief

	3
	Format Content Plan
	n8n-nodes-base.set
	Structures content into platform/day format for scheduler

	4
	Send Plan for Approval
	n8n-nodes-base.slack
	Posts preview of week's content to marketing channel for review



AI SYSTEM PROMPT
	You are a social media content creator. From this weekly brief, create Mon/Wed/Fri posts for LinkedIn (professional, 3-4 sentences + hashtags), Facebook (conversational, CTA), and Instagram (punchy caption + hashtags). Respond in JSON: {monday:{linkedin,facebook,instagram}, wednesday:{linkedin,facebook,instagram}, friday:{linkedin,facebook,instagram}}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
SLACK_MARKETING_CHANNEL=<your value here>
BUSINESS_NAME=<your value here>
BUSINESS_INDUSTRY=<your value here>



INTEGRATION NOTES
After approval, connect to Buffer, Hootsuite, or SproutSocial API to automatically schedule approved posts. Buffer's free tier supports 3 channels and is an ideal starting point for most SMB clients.

UNI-03
AI Sales Proposal Generator

The moment a deal enters the proposal stage in CRM, this workflow generates a customised proposal draft using the prospect's details, pain points from notes, and the salesperson's previous interactions. Delivered to the salesperson for final polish — cuts proposal writing time by 70%.
	Trigger
	Webhook — CRM deal moves to proposal stage

	Hours saved
	3–5 hrs/proposal

	Build time
	2–3 days

	Monthly retainer
	$350–$550/mo

	Connections
	CRM Webhook → Fetch Deal Context → AI → Email to Salesperson



NODE BREAKDOWN
	#
	Node Name
	Type
	Purpose

	1
	CRM Deal Stage Webhook
	n8n-nodes-base.webhook
	Triggered when deal stage changes to proposal in CRM

	2
	Fetch Deal & Contact Details
	n8n-nodes-base.httpRequest
	Retrieves full deal context: company, contacts, notes, activities

	3
	AI: Generate Proposal Draft
	n8n-nodes-base.httpRequest (Anthropic)
	Creates complete, personalised proposal structure from deal context

	4
	Deliver Draft to Salesperson
	n8n-nodes-base.gmail
	Emails the proposal draft to the deal owner for review and personalisation



AI SYSTEM PROMPT
	You are a senior sales professional. Create a compelling, personalised proposal draft: 1) Executive summary (their problem), 2) Understanding of their situation (using their own words), 3) Proposed solution (specific to their needs), 4) Why us (3 specific differentiators), 5) Investment overview placeholder, 6) Next steps. Be specific, reference their industry. Respond in JSON: {title, executiveSummary, situationAnalysis, proposedSolution, whyUs, investmentOverview, nextSteps}



	REQUIRED ENVIRONMENT VARIABLES
ANTHROPIC_API_KEY=<your value here>
CRM_BASE_URL=<your value here>
CRM_TOKEN=<your value here>
SALES_EMAIL=<your value here>
BUSINESS_NAME=<your value here>



INTEGRATION NOTES
The quality of the proposal depends entirely on the quality of notes in the CRM. Train sales staff to log pain points and key context in deal notes. The AI can only work with what it's given — garbage in, garbage out.


APPENDIX A — N8N SETUP & DEPLOYMENT GUIDE

Self-Hosted n8n Setup (Recommended for all Securafy clients)
All Securafy automations run on a self-hosted n8n instance within the client's own infrastructure. This ensures client data never leaves their environment and meets the security requirements of law firms, CPA firms, and compliance-sensitive manufacturers.
Step 1 — Server Requirements
1. Minimum: 2 vCPU, 4GB RAM, 50GB SSD
1. Recommended: 4 vCPU, 8GB RAM, 100GB SSD (for clients with 5+ active workflows)
1. OS: Ubuntu 22.04 LTS (preferred) or any Docker-compatible Linux
1. Outbound HTTPS access required to: api.anthropic.com, api.openai.com, api.hubspot.com, APIs of client's tools

Step 2 — Docker Installation (fastest path)
	REQUIRED ENVIRONMENT VARIABLES
# Install Docker
curl -fsSL https://get.docker.com | sh

# Create n8n data directory
mkdir -p ~/.n8n

# Run n8n with PostgreSQL (production-grade)
docker run -d --name n8n \
  -p 5678:5678 \
  -v ~/.n8n:/home/node/.n8n \
  -e N8N_BASIC_AUTH_ACTIVE=true \
  -e N8N_BASIC_AUTH_USER=admin \
  -e N8N_BASIC_AUTH_PASSWORD=<strong-password> \
  -e WEBHOOK_URL=https://n8n.client-domain.com \
  --restart unless-stopped \
  n8nio/n8n



Step 3 — Import Workflows
1. Open n8n interface at https://n8n.client-domain.com
1. Navigate to Settings → Import Workflow
1. Import individual workflow JSON files or the master _SECURAFY_ALL_WORKFLOWS.json collection
1. Set all required environment variables in Settings → Environment Variables before activating
1. Test each workflow with the Execute Workflow button before setting to Active

Step 4 — Credential Setup
1. Gmail: Settings → Credentials → Add Credential → Gmail OAuth2 (requires Google Cloud Console app)
1. Slack: Settings → Credentials → Add Credential → Slack API (requires Slack App with correct permissions)
1. HubSpot: Settings → Credentials → Add Credential → HubSpot App Token
1. QuickBooks: Settings → Credentials → Add Credential → QuickBooks OAuth2
1. Clio: Use HTTP Request node with Bearer token from Clio Developer Portal


APPENDIX B — AI PROMPT CUSTOMISATION GUIDE

Each workflow's AI system prompt is designed to be customised for the specific client. Here are the key variables to personalise in each prompt:
Firm/company name and identity
Replace generic references with the client's actual firm name, industry positioning, and specific service descriptions. The AI's output quality improves dramatically with more specific context.
Tone and voice descriptors
Add adjectives that match the client's brand voice to the system prompt. Examples: 'formal and precise' (law firms), 'approachable and expert' (accounting), 'warm and exclusive' (clubs). These 2-3 words significantly shape every output.
Staff names and roles for routing
Where prompts reference 'assign to the appropriate team member', include actual staff names and their specialisations. E.g.: 'Assign tax matters to Sarah (sarah@firm.com), estate matters to James (james@firm.com).'
Client-specific terminology
Some clients use specific internal terminology (e.g. 'file' vs 'matter', 'member' vs 'client', 'associate' vs 'employee'). Update prompts to match. Consistency with their existing language makes automations feel native, not foreign.
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